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This is the cover page.

This is the title page, which comes after the Cover page. 
It could also be the cover itself if your cover graphic is small.
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January, 2009
Limits of Liability & Disclaimer of Warranty
I AM NOT AN ATTORNEY. 
DO NOT USE THE FOLLOWING TEXT UNLESS YOU 
HAVE YOUR OWN ATTORNEY REVIEW IT FIRST.
The author and publisher of this ebook and the associated materials have used their best efforts in preparing this material. The author and publisher make no representations or warranties with respect to the accuracy, applicability, fitness, or completeness of the contents of this material. They disclaim any warranties expressed or implied, merchantability, or fitness for any particular purpose. The author and publisher shall in no event be held liable for any loss or other damages, including but not limited to special, incidental, consequential, or other damages. If you have any doubts about anything, the advice of a competent professional should be sought. 

This material contains elements protected under International and Federal Copywright laws and treaties. Any unauthorized reprint or use of this material is prohibited.

About the Author
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YOUR NAME is an important one. And who you are is important, too. So write something about yourself here. Adding your own photo helps people get to know you better. 

Wondering if you should do this? Take a look at almost any hardcover book, and you'll see a short bio of them probably on the dust jacket. 

Take your time here, one of the reasons to write this section is because you want the reader to get to know you, and to be motivated to read the entire book, rather than to return it. 

Make sense? 

Notice how the book wraps around the photo here and continues on down the page. 

Include a link to your website here, and maybe a support email address or link. For example, all of my support resources are available on my help desk. 

You can reach Mark at  http://www.MarksHelpDesk.com 

Table of Contents
3About the Author


4Table of Contents


5Introduction


6Foreword


7Chapter 1 Title Goes Here


7Subheadings


7Sub-Sub-Headings


8Chapter 2 Title Goes Here


8Adding Links in your Ebooks


9Adding Images to your Ebooks


10Chapter 3 Title Goes Here


12Resources




Introduction

You don't have to call your introduction an 'introduction', but you can. 

This is a good place to tell stories, and to get someone interested in the topic more than they might have been when they first ordered the book. 

It's important, right from the start, to motivate someone to want to read your book. Think of writing your introduction much like you would write a sales letter. 

Tell a story about someone who failed in this area, and someone who succeeded. Or some other motivating story.

Add some proof. 

Tell them what you're going to tell them in the rest of the book, and how it forwards their initial reason for buying the book. 

You can even cite certain parts of the book. "In chapter 3, we talk about bla bla bla, and you'll discover how one person did X and later found out he got Y in return. Wouldn't you like to get Y, too? Then read chapter 3."

You can even talk about how this book came to be. Why did you write it? What's doing on the world that made you just HAVE TO write this book?

And so on…

Foreword

You see this a lot in print books, but seldom in an ebook. 

Forewords are often written by other people well known in the industry. For example, if you could get Martha Stewart to write the forward on your napkin-folding book, well you'd have something to talk about. 

What if you wrote a book on how to coach a kid's soccer team? Well David Beckham would be a first choice for me to write my forward. 

It's unlikely I'd be able to get either of those celebrities, but you get the idea.  

Who do you know in your area of expertise who is better known than you?

That's who you want to have write your foreword for you. 

If you can get a good foreword, it's something you can boast about on your sales page. More importantly, you can issue a press release that your celebrity has written the foreword. 

Looking for a way to launch your book? That's not a bad one!

But look, if you choose not to have one, then so be it. It's certainly not required. 

Chapter 1 Title Goes Here
So here's where you start writing all of your content. Notice that each chapter heading begins with a "Heading 1" style paragraph. 

You can see all the styles available to you by clicking Format | Styles and Formatting. 

A window will open on the right side of the screen, and you can choose any of the available formats -- and even alter existing formats -- and then apply the formats to the text you write. 

So, the heading is a Heading 1

Subheadings

You can even have subheadings. The nice thing about subheadings is that they appear below the headings in the Table of Contents, but indented. Proper use of subheadings serves a few purposes. 
Principally, it helps to organize your book in the reader's mind. By skimming your headings and subheadings, your reader can really see what the book is about. Then when he or she reads your book, it's easier to follow. 

Sub-Sub-Headings

You can even go deeper in this hierarchy, by creating sub-sub-headings. They're really helpful.

Now let me caution you that you shouldn't overuse subheadings. Only use them if you have two or more of them at this level. So the way I have just one subheading and one sub-sub-heading isn't something you should do in real life. 

Plus, overusing them just makes your work look cheap…as though you're just looking to fill up space. 

Chapter 2 Title Goes Here
You can write lots more, chapter by chapter. The nice thing is that your Table of Contents is created for you automatically. 

One little tip…When copying and pasting in text from other applications, try pasting them into Notepad first, and then copying from there, before pasting into Word. The reason is that the formatting from the old application will usually get transferred to MS Word, and you might not want that. 

Pasting the text into Notepad, and then copying it from there and pasting into your ebook will actually paste in "plain text" and as a result, the text will be formatted the way the surrounding text is formatted.

Adding Links in your Ebooks
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By the way, you can make links in your ebook just by highlighting the text you want to turn into a link, and then clicking the little globe+chainlink icon in the toolbar in MS Word. For example, I can link to Google. More importantly, I could link to another product of mine, or use an affiliate link to sell someone else's product.
Important Advice About Linking from your Ebook

Make sure that ALL of the links you put in your ebook are redirects through a domain that you own and control. In other words, don't just put the affiliate link as the link. Learn how to do a redirect so that the traffic ALWAYS goes to your site first, and then to your affiliate. 

Why? 

Because that way if the website changes or dies, you can switch the traffic to another website. Plus, you can also count your clicks if you wanted to. But this is critical when adding links. 

Adding Images to your Ebooks

By the way, did you notice the image above? 
Want to know how it got there? Simple…
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First, you'll notice it's a screen shot. I did that using Snagit, a screen capturing program. It has tools in it for adding arrows and other shapes, and is positively the second most important tool that I use. (The most important one I use is Roboform, but that's a topic for another day.)

I used Snagit to make the picture, but no matter how I got the image, I can add it to my ebook by simply dragging it onto the page, or copying and pasting it onto the page. Either way works fine. 

Once it's on the page, I right-click the image, and choose "Format Picture." Then I choose the "Layout" tab. On that tab, choose "square" for the wrapping style, and then "right" for the alignment. 

Of course, if you want the image on the left side, choose "left". 

In any case, click OK, and you're done. From there, you can still move the image around a bit on the page by clicking and dragging. 

Images help make your ebooks more interesting and more readable. 

Chapter 3 Title Goes Here
One great way to add value to your ebook is to include "Pull-Quotes". A Pull Quote is text from the book that you are emphasizing, typically in a larger font, and in a box. 
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There's an example of a pull quote below, with the entire paragraph above inside of it. 

Here's how you create a pull-quote in Word 2003. Click "Text Box" on the "Insert" menu. Two things will actually be added to your page. One is a drawing box, which you can delete. The other is a plain text box. 

Type or paste your text into the text box, and make it the size and format you want it to be. (I like a serif font, italicized, and slightly larger than the body text.)

New! Click "Format | Styles and Formatting" and choose the "pull quote" style for your pull quote. Now, all your pull quotes will be formatted the same way. And you can change them all at once by changing the properties of the "Pull Quote" style.

Now, right-click on the text box border and click the format tab. Choose "square" and "right" so that the body text wraps around the left side of the text box. (see image below)
Then, click the "colors and lines" tab and put a black border line around the pull quote. You can shade it too, if you want to. 

That's it!

You've got a pull quote. 

Here's some place-holder text, just to fill out this sample page. 

Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. 
Chapter 4 Title Goes Here

Headers and footers can help make your book more legit. They're also a great help for your reader, because that is where your page numbers are going to be. 

Of course, you'll also want to put your copyright notice on every page, and this is the right place for that too. 

See the bottom of this and every page in this template for footer examples. 

You can edit the existing footer by double-clicking any one of them. And you can add footers to a new document by clicking "Headers and Footers" on the View menu. 

Resources

It's a good thing to end your ebook with a "resources" section. 

In sections like this, I tend to include a short writeup of the things I talked about earlier in the book, and include an affiliate link to purchase them. For example:

Microsoft Word is the de-facto  program for writing ebooks. It has all the features you need to create and format your book properly. Plus, it works well with Adobe Acrobat to make PDF files of your ebook. Get Microsoft Word here.
And I referenced Snagit before, too. Snagit is an indispensable utility when creating ebooks. You can capture images from the web and instantly paste them into your ebook. More importantly, if you want to talk about something on your screen, there's no beating a screen shot, and Snagit does that fantastically. Get Snagit here. 

If you' find yourself logging in to a lot of websites for your internet marketing work, like autoresponders, shopping carts, your blog, membership sites…and on and on…use Roboform to have your computer remember all your passwords for you. VERY HIGHLY RECOMMENDED, and FREE to try http://www.RoboformFreeTrial.com 

One great way to add value to your ebook is to include "Pull-Quotes". A Pull Quote is text from the book that you are emphasizing, typically in a larger font, and in a box. 
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